Directions for using Netplay
(Strat-o-matic Baseball, Computer Game ver. 10.01b)

Written by R. Joshua Shapiro
aka, the Skokie Wolfman
October, 2005
The goal of this paper is to fully document (or as much as possible) how to work with the Netplay version of the CD computer edition of Strat-o-matic Baseball based upon the 10.01b edition for Microsoft Windows.  However, there is an assumption made, that the person reading this document already knows how to play the SOM Baseball game and use all the features one needs to use during the game.  The Netplay feature or program is an additional program that comes with the SOM Baseball game that allows to people to play the game over the internet.  When you install the game on your computer, in the menu option for Strat-o-matic Baseball Game under Programs, you will see a separate entry for: CD Rom Baseball {the normal mode}; Net Play - Home Team {when you are the home team}; Net Play - Visiting Team {when you are the visiting team}.  Also at times I do quote some things given in the help file of the CD game about Netplay (so noted).
(From Help in the Game about Netplay:  The following features are not supported by Net Play:  Drag and drop in the lineup screen (keyboard commands replace the drag and drop functionality), Notebooks, Compare screen, Quick Spectator mode, Cannot access computer manager from pre-game menu, Clicking on Dice/Splits to start the dice rolling and Tactile Dice & splits, The "Regulator", Ballpark Entry Pictures, Player Pictures.

I have also copied images of the screen for the game so it is very clear what you have to do, what settings to check or turn on.  I strongly recommend that you also check with your league commissioner to determine which files the game saves that are needed for your league.  The examples given here are based upon the files needed for the computer league we are a member of called the CBA.  Note: the home team is the host machine and the visiting team is called the remote machine.
How to Connect with Your Opponent

For the Visiting Team -- you must ask your opponent what is the IP (internet) address of their computer.  Every computer connected to the internet has an address which is called the IP address.  In the next section it discusses how the Home Team is able to obtain this IP address and sent it to you.  Then you run from the Windows Program Menu, Net Play - Visiting Team.  When you do so, you will have two screens come up as follows:
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In the screen image above, you see a program called Netlink running -- this is the communication program supplied by SOM to allow you to speak to another player via the internet.  To connect to your opponent you should type underneath where it says Enter Host Name/Address the IP address given to you of the internet address of your opponent's computer.  This address will have a format as follows (where xxx represents a number): xxx.xx.xx.xxx such as 10.11.11.333.  After you type this address in, you will see at the bottom of the screen a communication line, with a message saying it is trying to connect with your opponent.  If it is successful, then the chat window (see later for what this window is) will come up and will look like this:
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When you connected to your opponent you see the Chat Window pop up and stated you are connected like what you see on the left.  If this doesn't happen, there will be another window that pops up and will give an error message.  It is not the goal of this document to cover the errors but we do include some info in the next section how to get NetPlay home to work properly.

For the Home Team -- First you have to find out the IP address of your computer.  If you are using a dialup modem, then to get the IP is very simple.  If you view the next graphic below you will see the screen you receive while you are waiting for you opponent to connect with you:
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In the screen image shown above, it shows the two windows which will open.  On the left is the leagues that are available to be played via Netplay and on the right is the Chat Window (which is where you will receive your the IP address of your computer) and in this case, it shows a message that you are visiting for your opponent the visiting team to connect with you.  
If you use a wireless router that is not directly connected to the internet but goes through your cable or ADSL modem, we have found that it works better to direct connect the computer with the game to this modem and not through your wireless otherwise you have another layer of IP addresses which is too confusing.  The next section discusses with the use of these new sophisticated and smart modems (there is software programs that talk to the modems) that finding the right IP address to give to your opponent can be a bit complicated.  If this is your case, please read what is following.

Please Note about the IP Address:  I have discovered that if you have a sophisticated modem (like a cable modem or ADSL modem) the IP address given by the game here is an internal IP address and not the external IP address known to the world via the Internet.  An internal IP address is the IP address within your personal network that is based upon the IP of the modem.  For example in the above illustration, the IP address shown of 10.0.0.2 is connected to the modem IP which could be 10.0.0.110 -- it will always be the same first three group of numbers with a different last number.  To find out the true IP of your system, you should go onto the internet and go into your web browser and visit:  

http://www.whatismyip.com -- this website will show on the browser window your true IP address and this is what you have to give to your opponent.

However, the SOM game company states that for Netplay home to work the port #508 (there are a number of doors or port numbers held within every computer which are available for their to be communication between computers on the internet, each program has its own port it uses) -- this Port number must not be blocked and if you are using a program with a Firewall for the internet to also turn it off.  So what I had to do is connect my internet provider and ask the following questions:

1) What is the IP address of the modem we are using?

2) How do I use the software built in to the modem to setup for
the internal IP address of my computer and attach it to this Port 508?

I can only share the procedure of what we did on our computer but each modem might call this IP re-routing service a different name.  The key is you have to let the modem know that for the internal IP of your computer directly connected by the wire, that it is ok for a program to use Port 508.

First we went into our web browser and we typed in the IP address of our modem as follows (example):  http://10.0.0.110
Next we saw in the browser, a window asking us for the Login and Password to access the modem (ask your internet provider or manufacturer of the modem for this or how to setup a password).  We entered this and then in the browser window was an interactive menu of functions we can execute to speak to the modem.  The service we asked for is called NAPT (Network Address Port Translation) and we had to setup two entries in a table for our computer (say its internal IP address then is 10.0.0.1) -- one for tcp and another one for udp.  Below are some screens from our system so you can see visually how this works:
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On the previous page, we see four NAPT entries for my notebook computer.  Also these are temporary addresses.  You see there are two addresses for the Port 508 (in this example the internal address of the computer via the modem is 10.0.0.2) one using a tcp protocol and the other uses an udp protocol just to make sure.  The bottom part of this screen shows how to setup to link Port 508 to the computer -- first define the protocol, type in the Inside IP (of your computer through the modem), the outside IP uses 0.0.0.0 and type in the Port 508 for both the Inside and Outside Port and save this.  Please Note, it is important to save your settings to your modem and it might temporarily disconnect and then restart itself to keep these settings in its memory.

It is unknown if other modems call this process of Forwarding or Linking a Port to an IP Address, NAPT, check with your internet provider.
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The Chat Window -- the chat window is exactly what it says, it is a window you can type messages to your opponent as is shown below -- where we see a message from the Visitor to the Home team (howdy).  Who sends the message is shown as Visitor or Home.  Another thing the chat window is used for is to show the settings used for the game.  We have found that if you can chat with your opponent via one of the free services like MSN Messenger, AOL IM or Yahoo Messenger, that when you chat with your opponent, especially during the game, it will slow down how fast the game comes back to your control.  But if you don't have one of these free services this is the only way you can speak to your opponent when you are playing.
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Here is the NetLink Menu, this is where you can break or make a connection also with your opponent over the internet.  The Applications Menu Option I am not sure of its use.

So at this point, you will be connected over the internet with your opponent.  The Home Team has the ultimate control of how the game works and all the files that are saved to record the game and its statistics are also written to the PC of the Home Team.  Actually the Home Team has a bit more work to do then the Visitor.

Now let's look at how you setup to play the game and what setting options you can use in Netplay?

Select Your Game to Play  -- Of course first you have to let Netplay know if you are going to play a scheduled (league) game or a non-scheduled (exhibition game).  To do this, go to the File Menu, and select either New Scheduled or New Unscheduled.  If you select a new scheduled game, then the following window will pop up, so you can indicate which game you wish to play.  Now since this is a Net Play game, a live game, you only want to play the game in question.  Therefore it is suggested to set your game to Manual and all the other league games to hold as follows:
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In the example above, it is assumed that Chicago White Sox are playing the Kansas City Royals in a Scheduled Netplay game.  So we have set that game to Manual (Using the drop down selector at the top left) and then set all the other games to Hold, so those games are not played.  Then click on the Play Day button.  After you have completed this screen, a setup screen comes up with the teams already selected to play for this day.  (If this is not a scheduled game, then you will see the setup screen immediately next and will not be presented with the screen above plus you will have to chose which teams from which league to play, and also a month, date and time.)  Lastly, it is also possible to save a game being played at any time (you give it an impropriate file name) and to go back to resume the game at a time later by going to the File Menu and select "Open Game".
Screen Setup (Lineups / Eligible Players / Starting Pitchers)
The Setup Screen in not play is exactly the same as in Normal Play but how you pick the players to use is done differently because you can't move them on the screen, you have to use a combination of key strokes or working with a key stroke and the "ALT" key.  Anyway I will show sample screens here so you can see how it works and one key check box to mark for League Play to ensure the game files are created.
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This is the screen where both the Visitor and Home Team setup their eligible players, lineup and starter.  Since you are playing live, a computer manager is not used.  At the top part of this screen is a check for League Game, if this is not checked, you can not Create Game Result Files (the check box at the bottom which will generate the home and visitor files for keeping statistics from the game, in the Export directory -- Note: if this is a non-scheduled or exhibition game, these two files are not generated.).  Also as in the normal game, you must indicate if there is a DH (Use DH Rule).  

Another unique button on this screen is in the top right is a button for Visitor (thus this is the setup screen for the Home team) -- which means when you finish organizing your team for the game, you hit this button and pass control to the Visitor's team (or this button would be labeled Home for the visiting team's setup screen).  So what happens with this button is pressed:  When the Home or Visiting Manager is done with their changes to their team (eligible players, starting pitcher or lineup) then they will click this button to transfer control to their opponent.  When both managers are finished and ready to play the game, the Play Ball button is hit (can only be initiated by the Home team).
Another important feature to make sure that you set on the setup screen (this can also be done within the Game Preferences option, see later) is that both teams have selected Manager as Human.  Also if this is a league game you will have to set the correct date and time of the game as shown by Month and date, plus day or night.  
Other buttons on this screen of note: Eligibles -- to set which player are in the major and minors; Starter -- which starting pitcher you wish to use; Lineup (which lineup to use in the game, please see next section) and finally when both teams are finished -- the Home Team only can click on the Play Ball button and the game will start.  For these three options on this screen, below are the windows that come up.
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This is ELIGIBLE screen allows you to pick which players linked to your team are eligible for the game.  Every league has rules how many players can play (normally it is 25 except the rosters can expand to more in last months).  Just click on the box next to the players name if they will be included in the day's game.  Those players shown in blue are in the minors (ineligible).
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This is the STARTER screen and here you can select which pitcher will start by clicking on their name and hitting the Select button.  This screen also shows information about the ballpark you are in and statistics about each pitcher.

Finally for the LINEUP screen, because you are playing over the internet and it takes a long time to send a redrawing of your computer screen, the Netplay game doesn't use drag and drop as is in the normal computer game mode.  Thus they have invented key combinations that you can use to decide which players will start, in what order in the lineup, what fielding position they will play and who is pitching.  The procedure for how to work with your players as described in this section not only works for the SETUP screen but also during the play of your game.  First, I will discuss how you can perform all these procedures to set your team and then we will look at some examples.
1) To set your lineup -- The game presents to you, your team in a window that is divided into 3 columns: The column to the farthest left are the players currently in the game or to be or being used; the middle column are the hitters who are still available and not in your current lineup and the last column are the pitchers who are available.  Note that when you use this screen at the beginning, you can free make any changes you want and all of your players are eligible to play.  However if you do exchange one player for another during the game, then the player you take out, will not be eligible (will not be seen on this screen) for the remainder of the game.
To change the order of where a player is hitting in your lineup, click on that player (he will become highlighted) and then hit a number from 1-9 to let Netplay know where he should hit.  The player currently hitting at that position and other below, will be pushed down one position in the order.

To put a new player into a position in your lineup (the left most column usually is already filled with a suggestive lineup) you click on the hitter in the middle column (he becomes highlighted) and then hit a number from 1 to 9, corresponding to the position in the lineup he should be inserted.  He will replace the player at that order in the lineup and assume his fielding position. 
To change the position in the field a player in your lineup is playing, you click on that player (he will be highlighted) and then hit Alt + number, where the number represents the position you wish this player to play as follows:  

1-pitcher 2-catcher 3-1B 4-2B 5-3B 6-SS 7-LF 8-CF 9-RF 0-DH.  Note if you use a DH, the pitcher will be listed underneath the 9 position in your order.
To change your pitcher (and insert him in the pitcher's spot if he is hitting), you go to the 3rd column that show the list of available pitchers and click on the pitcher you want to enter the game (he will be highlighted) and hit the letter "P" when he is highlighted and he will be inserted as the pitcher

Similarly if you wish to pinch run for a hitter on base, you highlight in the middle column the pinch runner you wish and click the # in the lineup of the player to pinch run for.

When the inning ends, the game will prompt you in a window (it says ERROR) to fill any positions you pinch hit for -- to set up your new lineup with replacements.
(From the Game Help:) To cancel the DH, click on the player in the lineup who will be replaced by the pitcher.  Then click Alt-C (that is hold down the Alt key then hit the letter C) and the pitcher will be inserted in that lineup slot.  You can replace any player currently in the lineup with the pitcher, including the DH.  If you do not replace the DH his position will change to a blank from "DH".  You can now assign him a position in the field.


On the next page is an example of this Lineup Screen, with some examples to show how to use it.
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Above is the Lineup Screen.  Here we see the three columns of players.  Also note two other features here -- in the left bottom of the screen is a button that either says Visitor or Home.  This is how you can switch between seeing which players are available to your team or your opponents (you also get to this screen during the game by hitting on the game control panel either the V or H buttons depending upon is you are Visitor or Home).  Another part of this screen we didn't mention before is the Read: section which is where if you have loaded a manager for your opponent, you can easily chose (it speeds up the game) a pre-set lineup versus a certain type of pitcher or your opponent may show names of pitchers on your or their team to use such a specific lineup for.  In this example for Tampa Bay there is only one lineup for left-handers and one for right-handers.
Examples:  

1) To change Crawford from LF to CF, you click on Crawford in the left column (he is highlighted) and hit Alt+8 key.  Then Baldelli position will become blank and you will either have to change his position or put in a new LF.

2) To move Crawford to hit 3rd in the lineup, you would click on Crawford in the current lineup column and hit the number 3, Baldelli and Huff would move up to positions 1 and 2.

3) To replace Blum at 3B with Cantu, you would click on Cantu in the middle column and hit 9 and he will be placed in Blum spot at 3B

4) To pitch run Upton for Hall, you would click on Upton in the middle column and hit 8 -- then after the inning is over, the game will ask you to replace your catcher.  You would click on Fordyce in the middle column and then hit 8 and then when Fordyce is in the left column, you would have to click on his name and hit Alt+2.
5) To replace Hendrickson with J. Sosa, you would click on J. Sosa in the right column and then hit "P" -- since this game has a DH, J. Sosa would not be inserted into the lineup.  However if there was no DH, you would still hit "P" and J. Sosa would bat in the pitcher's spot.

So these are the basic moves you can make with the Lineup Screen.  So when both managers are ready to play their game with Netplay, you will be back to the Setup Screen and the Home Manager hits the Play Ball button.
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So above you will come into the game screen where you see all the normal windows (scoreboard, play by play, stats on the hitter and pitcher, the cards and the control panel -- of course what you see depends on what options you have set up).  Please note there are recommendations of how to make your game go faster by not showing all these elements which we will discuss later.

Everything works the same in a normal game except you have a few extra features.  In the next sections we will speak about the settings for the game and these extra features.
Game Settings
There are basically four places or Options screens you use in the game that set up how your game is played, what forms of information is kept for the game and how quickly you will play the game by eliminating things displayed on your computer screen.  In this section we will discuss each of these Option Screens and what to check and why.  Each screen is found in the Option Menu of the Game. 

Note: If you have a league that already has all the options set already for your league play, these settings will carry over into your NetPlay games.  However, you can change them during the game, there is an options Menu in the Netplay version of the game.  
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In the Game Preferences Window, here are the options available.  We assume you are already familiar with these options.  For Netplay it is recommended to use "None for Entry Mode" (I prefer Dice Mode to see the cards and dice rolls but this does slow the game down).  For Play by Play Level (what is displayed about each play), it is recommended to No Play by Play or Minimal.  For Results and Options: Again if you don't show the flight of the ball or display trivia questions will help the speed in Netplay.  Also it is up to you if you want to Save Play by Play to File (some leagues require this, check with your commissioner).  Of course under Computer Manager, since this a live game, both should be unchecked.  And I am told a Base Delay for Animation of 7 or 8 is the best, again not to slow the game down too much.
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The Autoplay / BoxScore Options Screen is important for what files will be saved from your game.  In one of my leagues they suggest under Output to include the Boxscore, PAC (description of results of each hitter) and Scoresheet (these files are stored in Print and HTML folders, if you request to save HTML, see options following); for Output When -- it is suggested always so the appropriate files are created.  Generally people save the output to files.  On the other options shown on the screen as check boxes consult with the Commissioner of your league but the Create Game Result Files is pretty important and will generate the Home File (xxx.hxx) and the Visitor File (xxx.vxx) in the Export Folder which the games needs to update the statistics of both teams in the game.  For these files see the appendix for a discussion of the name conventions of these files. (See setup screen)
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Dice / Card / Split Settings Screen -- for speed purpose of the game you definitely want the dice rolled automatically and all together.  In our league for Base Delay a value of 5 is used.  Also let the Split cards be picked automatically.  However for showing the card image in the notebook, this could delay the game.  What I have found that works better is to have the regular game (Baseball.exe) running with Netplay and flip back and forth between the two to view the cards of your players or your opponents.  Also you can view the stats during the league of your opponent as well.  This will not slow down the response in Netplay if you do this.
[image: image17.jpg]Autoplay Options for 2004 Major Leagues

Output - What
€ Boxscore Only

€ PAC [Play Accounts) Only

@ Boxscore and Scoresheet
 Boxscore, PAC and Scoresheet

Output - When
 Never
@ Only For Event

Always

Output - Where
Save To File
€ Printer

% View Scores During Autoplay.
I~ Team vs. Team Subsets
I™ Day vs. Night Subsets

Default

play Game Story On Boxscore

Create Game Result Files
Home vs. Road Subsets
Subsets By Month

Cancel




Finally we have the Miscellaneous Screen and the most important options here, mostly for the files written is whether you want a special formatting to the print files (save in the Print Folder) and if you want to also keep a HTML version of the print files, in case you want to share these results via a website or just to view the printed files in a nicer format via a Web Browser.
Side Note: Whatever settings are chosen by the Home Team as well as how the game screen will look, is set by the Home Team. However, the visitor and the home teams can have how their windows appear differently such as the position on the screen of the control panel and scoreboard or how the play by play is handled.  If you move around the screen elements it will not affect what the other player sees on their screen.  
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Special Options/Features with Netplay

To your left is the main control panel.  The hitter button on the top left is used a bit differently.  Both the offense and the defense have to each push this button for play to continue.  First the defense has the option (to hold runners, position of infield or to intentionally walk a runner) and then the offense has the chance to move.  So it requires two presses of the Swing Away Button.
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Quick Substitution
If you hit at any time during the game "9" this window comes up.  Here you can substitute quickly one player at a position for another.  The drop down lists show all available players in the field or hitting, and the bottom one shows all eligible players who can replace the one in the  game.  This can speed up the playing of a Netplay game rather than using the Home or Visitor buttons.
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Delete the Last Play -- sometimes when you play Netplay you make a mistake, because you don't understand what one of the buttons on the control panels does or you replace a player incorrectly in your lineup.  So there is an option under the Edit Menu called Undo Last Play.  When you hit this button, the screens shown below will be displayed  and also your opponent has to agree to delete the results of the last play as well.
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Here the system is asking you if you are sure you want to request the last play deleted (in this case it was a single Counsell).  If you say yes, then another window pops up saying, your opponent must confirm (see below).


Here is the window that comes up for your opponent to ask if they agree to delete the last play.  If yes is given then the last play is redone.[image: image21.jpg]Fie | Edt Game Optons tep
Undo Last Play






What Happens when a Game Stops during play?
(Reconnecting a game that stops playing online)

There are is a special file that Netplay saves in the main directory of the game (CDROMBB) called pickup.sav.  Netplay automatically saves data to this file after each play.  If for some reason your connection via the internet  is disconnected.  Just restart the game and the Home Team goes to the File Menu, selects Open Game, and re-open the game using this file and you will be able to continue from where you left off.
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Game Menu Options




The Game Menu, is another way to control the flow of the game.  All the things you can do with the Control Panel, has a menu selection here. But in this menu are a few other options that can help you with the play of your game.  In this section we quickly review these additional selections.
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Get Information -- this option allows you to view information about your  own team or your opponent's team, various statistics to help you decides key moves to make during the game.
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Visit the Mound
Two visits to the mound and your pitcher must come out.  This options lets you check if the pitcher is fatigued.


[image: image25.jpg]You are allowed one mound visit per innning for each pitcher.

Do you wish to visit the mound?

Yes No



This window lets you know if your pitcher has reached his point of fatigue or weakness.

The Three Quick Options under the Game Menu

To speed the play of the game up, Netplay has three so-called quick options as follows:
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Quick Inning (Ctrl+Q) -- using this option gives control to the computer and the computer managers submitted to play your game quicker.  The game goes on until a man gets on base and then control is passed back to you.  When you choose this option, the window on the left comes up.

Quick Play -- This will play your game automatically for you to a selected inning using the Computer Managers submitted.  No action is displayed on the game screen and it only takes a second or so for this function to be completed.  Not sure this is a good option to use in Netplay (as it defeats the purpose for doing a Netplay game) but it exists.  Here you can select for which inning to quick play until the control of the game comes back.

Quick Spectator -- Like Quick Inning, but helps to finish your game much faster.  The difference of this option is that the game does not sop when a runner gets on base but keeps going until the game is done.  But you do get to watch all the events happen, you just can't change anything. You can exit Quick Spectator by clicking your mouse on the game screen.

(From the Game Help: - If you are going to be using the Quick Play or Quick Inning features be sure the visiting team e-mails an up-to-date computer manager to the home team manager who should import it before connecting.  The regular CD-ROM game can be used to do this.)
At the End of the Game  
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Game is Over -- when the game concludes the window to your left pops up, either to delete the last play of the game or to end it.  Below is the next screen which shows up, and that is to let the game know which statistical subsets to keep.  Please check with your league commissioner to see if any subset information should be kept for your games.
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Above are the type of subsets that can be saved for the game you just finished.  Again consult the league commissioner to see if the league requires any of these views of the game to be kept.

Files Created by Netplay that are Important
Besides the joy of being able to play people in your league all over the world live, there are also various files generated by the game that are needed for the league and the statistics kept.  I thought it might be a good idea to discuss these files and which settings make them.
Game Files (xxx.hxx & xxx.vxx) -- these are the files that have the stats for the game.  Each game you play will have two files created in the export directory, one for the home .hxx and one for the visitor .vxx.  The setting that saves these files is found on the Autoplay /Boxscores selection in the Options Menu.  You must check the box that says, "Create Game Files" (also check this  box is checked on the Setup Screen before you start your game.  Please Note, that if you play an exhibition game or unscheduled game, these two files are not created.

Suggestion for finding these files in the Export directory: You can either store all the files in the export directory into a temporary folder so the export directory is cleared or you should be able to determine these files via the date they are created.  

Here is a brief explanation for the naming convention used for these two files sent to me by a member of the Netplay mailing list:

The name used for these files includes the nickname of the league that they are associated with.  The only purpose of these files is to simplify stats updates for a league administrator. 

There is a strict naming convention for these files as follows:
The first six characters are the four-digit year and a two character league abbreviation. For example, if you are playing games using the 2003 MLB season, the files would begin with 2003ML. If you created a league for play this year with the two-character abbreviation QZ, the files would begin 2005QZ. If you select a league from the list in the left column, these six characters are the first to appear in the data box at the bottom.

The next two characters represent the specific visiting and home team. When the league was created, each team was assigned a number/letter for file continuity. The first team is number 0, the next number 1, and so on until the tenth team, which gets letter A. This unique character for each team is also used for all data files in the STATS and ROSTERS folders. For game result files, the visiting team character is always in position seven and the home team in position eight.

The last two characters in the file extension (.Hxx or .Vxx) represents

the sequential game number played between the two teams during that

season. These game numbers do not account for which team was home or

away. For example, a second three-game series between two opponents

played at the opposite park from the first series would include files

.H04, .V04, .H05, .V05, .H06 and .V06

Using this naming convention, it is very easy to find specific files when reporting stats to a league administrator or identifying specific files as a league administrator. These files are automatically placed in the EXPORT folder when created, should be placed in the IMPORT folder before using to conduct an update, and moved to the IMPORTED folder when the update is executed.

Boxscores & PACs files -- It depends upon the settings you indicate in the Autoplay/Boxscore Selection in the Options menu.  In Output What, you will indicate which of these views of the game to store (box scores, PACs, scoresheet).  In Output When (indicate always); Output Where (mark Save to File, this means these game views will be saved as .prt files in the PRINT Folder, under the appropriate sub-folder that represents the league the games are associated with.  You can also indicate on this option screen if you want the game story displayed with the boxscore.  If you want the HTML version of these game view files, then you have to go the Miscellaneous Selection of the Options Menu and check "Also Save print files as HTML".  Then you will find these files within the HTML Folder as .htm files.  The game with name a boxscore file with the word BOX (or a B is used in the name) in the  beginning and a PAC file with the word PAC in the file name (or a P is used in the name).
Play by Play File (PBP) -- If you want the Play by Play, another file will be saved with PBP as the beginning part of the name of the file and depending on the settings for Print files and HTML files discussed before, will be saved in the appropriate folders.  To set on for the Play by Play (PBP) information to be kept you will find this setting in the Game Preferences selection of the Options Menu and under Results and Options, check "Save Play by Play to file".
Subset Files -- these are files that provide an even greater detail of the game statistics.  The subset files are setup in Autoplay/Boxscore selection in the Options Menu and again are presented in a subset window at the end of the game.  These files are written to the subsets folder and have a file name using this convention:  (League Abbreviation)yy.Xyy (where yy is a number).  Again check with your league which subsets are being stored.
So the key is, you have to send to the League Commission whichever files are requested. This means you have to check the appropriate selections in the various game option windows to ensure these files are created.
IDEAS FOR SPEEDING UP NET PLAY  (From the Game Help)

- Forgo any unnecessary chat. Typing messages back and forth, between every other batter, will bog your game down.  Try to save chat for the key moments - there'll be plenty of time to chat after the game ends!
(We recommend: Use another chat program to talk with your opponent such as Yahoo Messenger or MSN Messenger {both free} or AOL IM).
- Use the minimum options for Entry Mode (None), Play-by-Play Mode (None), and Boardgame Info (No). Also, make sure that the "Base Delay for Animation" and "Base Delay for Play by Play" are set to the lowest number that you can comfortably use.  Using these minimum options will speed up play dramatically.

- Be prepared to play quickly, especially in the early innings. You'd think that this would be obvious, but experience shows that it is not. Players sometimes dawdle 5, 10, even 15 seconds, between batters. That really adds up over the course of 9 innings. For example, after the first out of a scoreless game, in the third inning, and nobody on, you should click the 'Swing' icon to return control to the offense as soon as the next batter appears. Have an idea in advance what you're going to do in a given situation.  That way if you are not going to make a move, you can immediately give control back to your opponent.  

- Utilize Quick Inning.  This mode can be utilized in the first 5 or 6 innings of the game to help speed up play.

- Utilize Quick Play. For example, you can use Quick Play till the 7th inning and then manually play out the rest of the game. 
- For league games (or short series), the Visitor should e-mail their Computer Manager to the Home team coach in advance, so it may be Imported prior to connecting  (Note: so you can setup the visitor's team lineup against the home team quickly).  Additionally, the Home manager should have his Lineups and Starting rotations set prior to connecting.  This alone can cut minutes off of each game.

(Author's Note:  The SOM game company discussed in their on-line help about a free Yahoo mailing list that has gamers who use Netplay {not only for Baseball but also over sports game by SOM}.  Go in your web browser and point to the following URL:


http://groups.yahoo.com/group/somnetplay  

Some of the help I received to do this document came from members of this group.  I recommend to receive the most benefit of the group and its mailing list, that if you don't already have a free Yahoo email, sign up for one so you can access all the features of this list.  Additionally you could meet other gamers to play all over the world using Netplay.
If any one is interested to contact the author of this document, feel free to email Wolfman at: joshuashapiro@xs4all.nl.  If you have some other additions to add for this document to make it a bit clearer, feel free to let  us  know.  We made this document to help us prepare for the playoffs for our first computer league team, the Montreal Royals in the CBA of which all games in the playoffs will be done via Netplay.  To learn more about the CBA go to:  http://www.cba.741.com/CBA.htm.  Enjoy and I hope this document has been of some help to explain how to best utilize the features of Netplay.)
